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Resumo
Este trabalho visa introduzir as formas de otimização utilizando as ferramentas baseadas em

elementos finitos ANSYS Mechanical APDL e ANSYS Workbench, através de uma metodolo-

gia para implementação de problemas de otimização paramétrica. De forma a apresentar as

ferramentas, será abordado um problema de uma viga simples como forma de validação e

problemas de estruturas treliçadas, sendo um problema de treliça planar (treliça de 10 bar-

ras) e um problema de treliça espacial (treliça de 25 barras).

Os resultados mostram que apesar de as ferramentas possuírem abordagens de otimiza-

ção diferentes, ambas conseguem entregar resultados próximos aos esperados na literatura,

sendo que a ferramenta ANSYS Mechanical APDL apresenta tempo de otimização mais curto

se comparado com a ferramenta ANSYS Workbench, porém pela descontinuidade do mó-

dulo de otimização na ferramenta ANSYS Mechanical APDL, sendo possível otimizar na fer-

ramenta somente usando a linguagem paramétrica, a ferramenta ANSYS Workbench é atu-

almente a mais usada para otimização estrutural.

Palavras-chave: Otimização, metodologia, paramétrica, APDL, Workbench, treliças



Abstract
This work aims to introduce ways of optimization using the tools based on finite element

ANSYS Mechanical APDL e ANSYS Workbench, through an methodology of implementation

of sizing optimization problems. In a way to present the tools, it will be approached an pro-

blem of a simple beam as a validation way and truss structure problems, being an problem

of a planar truss (10 bar truss) and an problem of a space truss (25 bar truss).

The results shows that despite the tools possess diferent optimization approaches, both can

deliver results close to the ones in the literature, being that the ANSYS Mechanical APDL tool

presents an shorter optimization time compared to ANSYS Workbench tool, but as the opti-

mization module has been discontinued on ANSYS Mechanical APDL tool, being possible to

optimize in the tool only using the parametric language, ANSYS Workbench tool became the

main structural optimization tool.

Keywords: Optimization, methodology, sizing, APDL, Workbench, trusses
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1 Introdução

A indústria na busca por competitividade vem demandando soluções que tornem seus

produtos mais eficientes e com baixo custo. Nesse sentido, segundo Haftka[4] a otimização

foca em alcançar o melhor resultado de uma dada operação enquanto satisfaz certas restri-

ções.

A otimização é uma das etapas de desenvolvimento de um produto, onde através de mu-

danças no design em um processo iterativo se alcança o ’melhor’ produto possível. O pro-

cesso de otimização de estruturas atualmente é realizado por métodos computacionais em

conjunto com o método de elementos finitos (FEM) e a dinâmica de sistemas multi-corpos.

Na busca por otimizar estruturas mecânicas, ao longo dos anos foram surgindo vários

métodos de otimização, porém foi com Schimit[11] que se iniciou o uso da combinação do

método de elementos finitos e dos métodos não lineares de otimização, realizando otimiza-

ção de tamanho em membros de estruturas treliçadas.

A otimização estrutural moderna tem como principais tipos de otimização estrutural a

otimização paramétrica, a de forma e a topológica, onde a paramétrica modifica a área de

seção transversal dos elementos da estrutura, a otimização de forma modifica a forma do

contorno interno e/ou externo dos elementos da estrutura e a topológica altera os elemen-

tos na estrutura através de análise de tensões na topologia da estrutura.

Como a otimização estrutural moderna utiliza técnicas numéricas em computadores

para resolução de problemas de otimização, surgiram vários softwares comerciais basea-

dos no método de elementos finitos (MEF) para realizar análise estrutural. Entre eles sur-

giu na década de 90 o ANSYS, que veio a incluir uma ferramenta para realizar otimização

paramétrica. Segundo a politica da empresa, diferentes versões do ANSYS, com diferentes

componentes ou módulos de cálculo, são comercializadas simultaneamente para atender

diferentes mercados.

O ANSYS era composto inicialmente pelo ANSYS Mechanical APDL que possuía um mó-

dulo de otimização, porém por utilizar a linguagem paramétrica própria de programação do

ANSYS, era necessário um conhecimento mais aprofundado desta para utilizar o software.

Em 2000, a empresa ANSYS lançou o software ANSYS Workbench, o qual tinha a premissa de

ser mais prático de utilizar. O ANSYS Workbench vem sendo aprimorado constantemente e

atualmente possui ferramentas para realizar otimização paramétrica, de forma e topológica.

Por meio das ferramentas comerciais ANSYS Mechanical APDL e ANSYS Workbench, esse
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Projeto de Graduação visa apresentar métodos de otimização através da resolução de pro-

blemas, com foco na otimização paramétrica que, apesar de ter perdido parte de sua rele-

vância devido ao uso da otimização topológica, ainda é bastante utilizada comercialmente

para redução de custos em projetos.

Motivação

A motivação dese trabalho é propiciar aos leitores um conhecimento básico do uso das

ferramentas ANSYS Mechanical APDL e ANSYS Workbench para otimização de estruturas,

como forma de formar engenheiros com conhecimento de otimização. Apesar de existirem

muitos tutoriais disponíveis na INTERNET, eles normalmente não apresentam as informa-

ções necessárias para o uso consciente e seguro do ANSYS em otimizações estruturais. Fal-

tam informações sobre a metodologia de otimização usada ou detalhes sobre a completa

configuração dos comandos e parâmetros de programação do ANSYS.

Por outro lado a literatura sobre otimização estrutural tende a ser muito matemática,

dificultando o seu entendimento pelos engenheiros projetistas; ou superficial e limitada,

apresentando apenas informações gerais sobre os métodos sem destacar os fundamentos

dos mesmos e, assim, permitir seu melhor uso na otimização estrutural. Alguns trabalhos

limitam-se a apresentar os softwares, seus comandos sem detalhar os aspectos ligados a

teoria da otimização ou mesmo ao método de elementos finitos.

O uso da otimização estrutural na indústria e a obtenção de resultados relevantes e con-

fiáveis demanda a correta combinação dos conhecimentos sobre a teoria da otimização, o

método de elementos finitos e o uso consciente dos softwares comerciais.

Objetivos

O projeto tem como objetivo apresentar uma metodologia prática de otimização estru-

tural utilizando o ANSYS Mechanical APDL e o ANSYS Workbench como ferramentas, com o

intuito de gerar um conhecimento básico e estruturado para futuros engenheiros que dese-

jem realizar trabalhos em otimização estrutural, garantindo a confiabilidade dos resultados.

Metodologia

A metodologia desse projeto consiste inicialmente em transportar o problema que se

deseja otimizar para os softwares ANSYS Mechanical APDL e ANSYS workbench, onde para

o ANSYS Mechanical APDL três etapas que devem ser seguidas em ordem:

1. Módulo de pré processamento (/PREP7): em que se definem a estrutura, suas propri-

edades, condições de contorno e as forças atuantes no problema;
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2. Módulo de processamento (/SOLU): onde se define o tipo de análise a ser executada,

podendo ser estática, dinâmica, vibração, flambagem, entre outros. Além de ser onde

se realiza a análise propriamente dita do problema.

3. Módulo de pós-processamento (/POST1): onde se obtêm os resultados do problema,

entre eles as tensões atuantes, deformação, modos de vibração, entre outros.

Após execução das etapas anteriores, devem-se salvar os passos realizados pelo software

em um arquivo, bem como tratá-los para usá-los na etapa de otimização.

No módulo de otimização (/OPT) ocorre a otimização do problema, onde utilizando o

arquivo salvo tratado, este será lido pelo módulo de otimização, onde serão inseridas as va-

riáveis a serem otimizadas e as restrições com o intuito de obtê-las otimizadas, assim será

iniciada a otimização onde o arquivo de solução do problema será iterado pelo módulo de

otimização a fim de obter a solução otimizada do problema.

Para o ANSYS Workbench é necessário:

1. Definir o material utilizado;

2. Definir a geometria a ser otimizada, bem como o elemento-tipo;

3. Gerar a malha do problema;

4. Aplicar forças e restrições de deslocamento;

5. Solucionar o problema e obter as tensões;

6. Definir os parâmetros de entrada e saída;

7. Em Direct Optimization, definir as variáveis de desenho, de estado e a função objetivo,

bem como limites para então solucionar o problema.

Organização

Esse relatório está dividido em cinco capítulos, incluindo a introdução, referências bibli-

ográficas e anexos.

• Capítulo 2: é apresentada uma revisão dos conceitos básicos de otimização estrutural,

o processo de otimização abordando os principais tipos e sua formulação matemática;

• Capítulo 3: é apresentado o método de elementos finitos, sua importância no projeto

de estruturas e a formulação básica do método;
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• Capítulo 4: é apresentado um breve histórico da otimização no ANSYS, os softwares

ANSYS Mechannical APDL e ANSYS Workbench, o funcionamento do módulo de oti-

mização e do módulo direct optimization, usando como exemplo um problema de

otimização para validação das ferramentas, bem como as etapas para sua otimização;

• Capítulo 5: são apresentados 2 problemas de aplicação e os resultados obtidos usando

o ANSYS Workbench, além de comparar os resultados obtidos com a literatura;

• Capítulo 6: são apresentadas as conclusões finais.
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2 Otimização estrutural

A otimização estrutural objetiva fazer um conjunto de materiais sustentar cargas da “me-

lhor” maneira possível. O termo “melhor” se refere a melhorar a estrutura maximizando

alguns parâmetros, como a carga crítica, ou minimizando outros, como o peso, sempre bus-

cando um equilíbrio, onde a estrutura seja viável, atendendo os requisitos impostos.

O processo de otimização possui muitas variáveis de desempenho estrutural – peso, es-

pessura, carga crítica, tensão, deformação e/ou geometria – e para iniciar o processo de oti-

mização estrutural, seleciona-se uma ou mais variáveis que serão as variáveis de otimização,

que poderão ser maximizadas ou minimizadas, as outras variáveis serão restrições estrutu-

rais.

2.1 Processo de desenvolvimento de produto

O processo de desenvolvimento de um produto, em geral, segue uma sequência de eta-

pas que resulta em sua forma final. Segundo Christensen e Klarbring [12], as etapas são:

1. Função: Definir o uso do produto.

2. Design Conceitual: Definição do conceito construtivo a ser usado.

3. Otimização: Com o conceito escolhido e suas respectivas restrições, tornar o produto

o melhor possível.

4. Detalhes: São detalhes que são controlados pelo mercado, sociedade ou fatores esté-

ticos.

Na etapa de otimização, utiliza-se o método intuitivo iterativo, em que (a) define-se o

design, (b) verificam-se os requisitos do produto em função do uso, (c) se o produto não

atende os requisitos, um novo design deve ser escolhido e (d) com o novo design, retorna-se

ao passo (b). Com isso tem-se um processo iterativo que se inicia com um design intuitivo,

que converge para uma solução ótima.

No caso de estruturas mecânicas e no projeto de máquinas e equipamentos, a etapa in-

tuitiva de otimização é, atualmente, substituída por um método computacional de otimi-

zação. Usando as metodologias de otimização, combinadas com o método de elementos

finitos (FEM) ou métodos de modelagem de sistemas de multicorpos (MBD), os métodos

computacionais são mais eficientes, automatizados e confiáveis.

Nas seções seguintes esses métodos de otimização estrutural serão abordados.
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2.2 Tipos de otimização estrutural

Segundo Christensen [12], os problemas de otimização estrutural, dependendo da ca-

racterística geométrica, são divididos em três classes: otimização paramétrica, otimização

de forma e otimização topológica.

2.2.1 Otimização paramétrica

A otimização paramétrica ou dimensional otimiza as dimensões de uma estrutura, sem

alterar sua forma. Na figura 2.1 é apresentado um problema de otimização dimensional de

uma viga engastada, onde o problema pode ser reduzido a um sólido bidimensional, em que

o parâmetro de otimização da estrutura é sua espessura.

Desi g n i ni ci al Desi g n oti mi zado

F F

Figura 2.1 – Exemplo de otimização paramétrica

2.2.2 Otimização de forma

A otimização de forma utiliza como parâmetro de otimização a forma do contorno da

estrutura. É um método que pode apresentar formas bastante complexas, sendo necessário

refazer a malha de elementos finitos durante as iterações de design. Na figura 2.2 é apresen-

tado o problema de uma viga engastada submetida a uma força na sua extremidade livre.

Figura 2.2 – Exemplo de otimização de forma [12].

2.2.3 Otimização topológica

A otimização topológica permite a otimização de uma estrutura distribuindo o mate-

rial no interior de um domínio fixo, maximizando (ou minimizando) uma função custo, por
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exemplo a máxima rigidez e volume mínimo de material. No domínio, o material em de-

terminado ponto pode variar entre 0 (sem material) e 1 (presença total de material), sendo

que sua densidade pode assumir valores entre 0 e 1. Na figura 2.3 tem-se um bloco sólido

submetido a uma força no centro que após a realização da otimização topológica assumiu

uma nova forma, em que se verifica que houve remoção total de material em certos pontos

da estrutura.

Figura 2.3 – Exemplo de otimização topológica [12]

2.3 Teoria de Otimização

A teoria de otimização, segundo Christensen [12], sempre apresenta as seguintes variá-

veis e funções:

• Função Objetivo ( f ): É a função que classifica o conceito do projeto, retornando um

valor que mostra a qualidade do mesmo, para cada iteração. Para a função objetivo f

normalmente escolhem-se valores menores de f ao invés de valores elevados, pois a

maioria dos casos é de problemas de minimização, com f podendo medir peso, movi-

mento em determinada direção, tensão ou mesmo custo de produção.

• Variável de projeto (x): É uma função ou um vetor que descreve o conceito do projeto e

que pode ser alterado durante a otimização. Pode representar a geometria ou a escolha

do material. Quando descreve a geometria, pode ser uma função de interpolação da

forma ou simplesmente a área de uma viga, ou a espessura de uma placa.

• Variável de estado (y): Para um conceito x, a variável de estado y é uma função ou vetor

que mostra a resposta da estrutura. Pode ser o deslocamento, tensão, deformação ou

força.

Em geral, segundo Christensen [12] o problema de otimização estrutural (SO) tem a

forma:
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(SO) =


minimizar f (x, y) com relação a x e y

sujeito a


restrições de comportamento em y

restrições do conceito em x

restrição de equilíbrio

Pode-se ter também problemas com varias funções objetivo, chamados problemas de

otimização com múltiplos critérios, ou problema de otimização vetorial:

minimize ( f1(x, y), f2(x, y), . . . , fl (x, y))

sendo l é o número de funções objetivo, e as restrições são as mesmas do (SO).

Para apresentação das definições e conceitos associados ao problema de otimização se-

rão somente considerados problemas na forma (SO), ou seja problemas com uma função

objetivo escalar. A expansão para o caso de otimização vetorial é evidente. No (SO), usual-

mente são indicados três tipos de restrições:

1. Restrições de comportamento: restrições na variável de estado y , são normalmente

apresentadas na forma g (y) ≤ 0, onde g geralmente é uma função que representa o

deslocamento em determinada direção;

2. Restrições de conceito: são restrições similares envolvendo a variável de conceito x;

3. Restrição de equilíbrio: em um problema linear discretizado, pode ser representado

por:

K(x)u = F(x)

onde K(x) é a matriz de rigidez da estrutura, que normalmente varia com o design

(material e geometria), u é o vetor de deslocamento e F(x) é o vetor de força da estru-

tura, que pode variar dependendo do design. O vetor u geralmente será a variável de

estado y .

Em problemas contínuos, a variável de equilíbrio será uma equação diferencial parcial

(EDP). Além disso, em problemas de otimização estrutural dinâmica, se terá que considerar

o equilíbrio dinâmico.

A formulação (SO) tem x e y como variáveis independentes, sendo usualmente chamada

de formulação simultânea, pois o equilíbrio é solucionado ao mesmo passo que o problema

de otimização. Porém, uma situação frequente é que o problema de estado somente define

y para um dado x, i.e, se K(x) for inversível para todo x; tem-se que u = u(x) = K(x)−1F(x).

Tratando u(x) como uma função dada, a variável de equilíbrio pode ser tirada de (SO), e a
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função substituída pela variável de estado, que resulta:

(SO)nf =
{

min f (x,u(x))

s.t. g (x,u(x)) ≤ 0,

onde s.t. é "sujeito à", devendo assumir-se que todas as variáveis de estado e restrições

serão escritas como g (x,u ≤ 0), que é chamada formulação aninhada.

Ao tratar (SO)nf numericamente, necessita-se das derivadas de f e g com relação ao con-

ceito x. Como a função u(x) é dada implicitamente, obter as derivadas se torna uma tarefa

não-trivial. Obter tais derivadas é o objetivo da análise de sensibilidade.
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3 Método de Elementos Finitos

O método de elementos finitos (MEF) é um método numérico para resolução de pro-

blemas de engenharia e físicos. Problemas típicos que são resolvidos através do método

incluem a análise estrutural, transferência de calor, escoamento de fluidos, transporte de

massa e potencial eletromagnético.

O desenvolvimento moderno do método de elementos finitos começou em 1940 na área

de engenharia estrutural com os trabalhos de Hrennikoff em 1941 e McHenry em 1943, que

utilizaram linhas para representar treliças, para determinar as forças em um sólido continuo.

Porém somente quando Courant propôs o conceito de funções por partes contínuas em um

subdomínio, foi que o método dos elementos finitos teve seu real início.

A eficiência e flexibilidade do MEF permitiu seu amplo uso no meio acadêmico e indus-

trial. Diversos softwares comerciais utilizam o MEF, dentre eles ANSYS, ABAQUS, NASTRAN,

etc.

O método é baseado no processo de aproximação discreta, onde um meio contínuo em

geral é dividido em pequenos elementos com as mesmas propriedades do todo, transfor-

mando um problema infinito-dimensional em um problema finito-dimensional. As incóg-

nitas do problema formulado em domínios contínuos são denominadas variáveis de campo,

podendo assumir valores independentes em cada ponto do domínio. O problema é dividido

em regiões interconectadas que são chamadas elementos. Os elementos podem assumir di-

ferentes formas, como triângulos, quadrados, tetraedros e cubos.

Os elementos são compostos de pontos que são chamados de nós. O conjunto dos ele-

mentos utilizados na estrutura é denominado malha. Os softwares de MEF tem como função

calcular os valores das variáveis de campo nos nós e por meio da aproximação por funções

de interpolação definir valores para os pontos não nodais, garantindo a continuidade da so-

lução nos nós compartilhados pelos elementos. Assim, o método permite obter soluções

aproximadas com boa precisão.

3.1 Procedimento do MEF

Segundo Liu e Quek [7] e Leung [6], o procedimento padrão do método de elementos

finitos pode ser definido como se segue.
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3.1.1 Discretização do domínio

O corpo sólido é dividido em Ne elementos. Esse processo gera a malha, que normal-

mente é criada utilizando os pré processadores. Um exemplo é mostrado na figura 3.1, onde

se tem a malha de um sólido bidimensional.

O pré processador gera os elementos e os nós da estrutura sólida, todos numerados de

maneira única. O elemento é formado através da união dos nós, de maneira que todos os

nós sejam unidos formando o domínio do problema, não havendo lacunas ou sobreposi-

ção de elementos. O domínio gerado pode ter elementos de formas diferentes e com uma

quantidade diferente de nós, desde que os mesmos sejam compatíveis nas fronteiras dos

elementos, não havendo lacunas. A densidade da malha vai depender da precisão dos re-

sultados e dos recursos computacionais disponíveis, pois uma malha mais densa pode gerar

resultados mais precisos, porém demanda maior custo computacional.

Figura 3.1 – Exemplo de malha com elementos e nós numerados [7]

Os vetores serão definidos por chaves, enquanto matrizes serão definidas por colchetes.

3.1.2 Método do deslocamento

A formulação do MEF deve ser baseada em um sistema de coordenadas, sendo definidos

os sistemas local e global. Na formulação de equações para elementos no MEF, utiliza-se um

sistema de coordenadas local que é definido apenas para o elemento mas com referência ao

sistema de coordenadas global, que é definido para a estrutura inteira. Baseado no sistema

de coordenadas local definido em um elemento, o deslocamento em um elemento é definido

por uma interpolação polinomial usando o deslocamento dos nós (ou deslocamento nodal)
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como

{u(x, y, z)} =
nd∑
i=1

[Ni (x, y, z)]{qi } = [N (x, y, z)]{qe } (3.1)

Onde nd é o número de nós que compõem o elemento e qi é o deslocamento nodal no i-

ésimo nó, que pode ser expresso na forma geral:

{qi } =


q1

q2
...

qn f


→ deslocamento componente 1

→ deslocamento componente 2
...

→ deslocamento componente n f

onde n f é o número de graus de liberdade (GDL) em um nó. Para sólidos 3D, n f = 3, e

{qi } =


ui

vi

wi


→ deslocamento na direção x

→ deslocamento na direção y

→ deslocamento na direção z

As componentes do deslocamento podem consistir de rotações para estruturas de vigas e

placas. O vetor qe na equação 3.1 é o vetor deslocamento para todo o elemento e tem a

forma:

{qe } =


q1

q2
...

qnd


→ deslocamento no nó 1

→ deslocamento no nó 2
...

→ deslocamento no nó nd

Entretanto, o total de GDL para um elemento inteiro é nd ×n f .

Na equação 3.1, N é a matriz das funções de forma para os nós do elemento, que são pre-

definidos assumindo a forma das variações do deslocamento com respeito as coordenadas.

Tem a forma geral de

[N (x, y, z)] = [{N1(x, y, z)} {N2(x, y, z)} . . . {Nnd (x, y, z)}]

↓ ↓ . . . ↓
nó 1 nó 2 . . . nó nd

onde [Ni ] é a submatriz das funções de forma para componentes de deslocamento, que é

organizada como

[Ni ] =


{Ni1 } 0 0 0

0 {Ni1 } 0 0

0 0
. . . 0

0 0 0 {Nin f
}


onde Nik é a função de forma para o k-ésima componente de deslocamento (GDL) no i-

ésimo nó. Para sólidos 3D, n f = 3, e frequentemente Ni1 = Ni2 = Ni3 = Ni .
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Tal abordagem de assumir os deslocamentos é normalmente chamado de método do des-

locamento, porém também existem abordagens do MEF que assumem as tensões ao invés

do deslocamento, porém não serão abordadas aqui.

3.1.3 Matriz das funções de forma

Segundo Leung [6], para o método do deslocamento padrão, o campo de deslocamento

pode ser assumido como:

{u(x, y, z)} = [φ(x, y, z)]{α}

Onde [φ(x, y, z)] é o vetor dos modos de deslocamento e {α} é o vetor das constantes a serem

determinadas pelos deslocamentos nodais. Para cada nó i, o vetor das componentes do

deslocamento é dado por:

{qi } = {u(xi , yi , zi )} = [φ(xi , yi , zi )]{α}

onde (xi , yi , zi ) são as coordenadas do nó. Se todas as componentes dos n nós do elemento

forem agrupadas em um vetor {qe }, então:

{qe } = [Φ]{α}

onde a matriz constante [Φ] é dada por:

[Φ] =


{φ(x1, y1, z1)}

{φ(x2, y2, z2)}
...

{φ(xn , yn , zn)}


e o campo de deslocamento é expresso em termos do deslocamento nodal:

{u(x, y, z)} = [φ(x, y, z)][Φ]−1{q} = [N (x, y, z)]{q}

Onde [N (x, y, z)] = [φ(x, y, z)][Φ]−1 é a submatriz das funções de forma, que é apresentada

na equação 3.1.

3.1.4 Princípio de Hamilton

O princípio de Hamilton é uma ferramenta usada para derivar sistemas de equações di-

nâmicos discretizados. O princípio constata que de todo o histórico temporal de desloca-

mento, a solução mais precisa torna a função lagrangiana miníma.

Um deslocamento compatível com o princípio de Hamilton deve satisfazer as seguintes con-

dições:

1. equações compatíveis;
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2. condições de contorno cinemáticas;

3. as condições no tempo inicial (t1) e no final (t2).

Matematicamente, o princípio de Hamilton pode ser expresso como:

δ

∫ t2

t1

Ldt = 0 (3.2)

O termo lagrangiano L consiste de:

L = T −U +W f (3.3)

onde T é a energia cinética, U é a energia potencial (mas para o caso, é a energia tensional

elástica) e W f é o trabalho realizado por forças externas. A energia cinética do domínio do

problema é definida na forma integral como:

T = 1

2

∫
V

[ρ]{u̇}T {u̇}dV (3.4)

onde V representa todo o volume do sólido e [ρ] é a matriz de inércia.

A energia tensional do domínio é expressa como:

U = 1

2

∫
V

{ε}T [C ]{ε}dV (3.5)

Onde [C ] é a matriz das constantes elásticas. O trabalho realizado por forças externas pode

ser obtido por:

W f =
∫

V
{u}T [ fb]dV +

∫
S f

{u}T [ fs]dS f (3.6)

3.1.5 Formulação das equações de elementos finitos

O campo de tensões é obtido da relação cinemática como:

{ε(x, y, z)} = [B(x, y, z)]{q} (3.7)

Onde B é a matriz de tensões e pode ser definida como:

{B} = [L][N ]

onde [L] é o operador diferencial.

Substituindo a equação 3.7 na energia tensional (eq. 3.5), tem-se:

U = 1

2

∫
Ve

{ε}T [C ]{ε}dV = 1

2

∫
Ve

{qe }T [B ]T [C ][B ]{qe }dV = 1

2
{qe }T

(∫
Ve

[B ]T [C ][B ]dV

)
{qe } (3.8)

Onde o subscrito e é para elemento.

Para um sólido 3D, o operador diferencial pode ser denotado como:

[ke ] =
∫

Ve

[B ]T [C ][B ]dV
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que é chamado de matriz de rigidez do elemento, substituindo na equação 3.8 tem-se:

U = 1

2
{qe }T [ke ]{qe } (3.9)

A matriz de rigidez [ke ] é simétrica, com isso somente metade dos termos da matriz devem

ser avaliados e armazenados.

Substituindo a equação 3.1 na equação 3.4, tem-se:

T = 1

2

∫
Ve

[ρ]{u̇}T {u̇}dV = 1

2

∫
Ve

[ρ]{q̇e }T [N ]T [N ]{q̇e }dV = 1

2
{q̇e }T

(∫
Ve

[ρ][N ]T [N ]dV

)
{q̇e }

(3.10)

Considerando:

[me ] =
∫

Ve

[ρ][N ]T [N ]dV (3.11)

que é chamada de matriz de massa do elemento, a equação 3.10 será:

T = 1

2
{q̇e }T [me ]{q̇e } (3.12)

A matriz de massa do elemento também é simétrica.

Para obter o trabalho exercido por forças externas, substitui-se a equação 3.1 na equação 3.6,

resultando em:

W f =
∫

Ve

{qe }T [N ]T [ fb]dV +
∫

Se

{qe }T [N ]T [ fs]dS = {qe }T
(∫

Ve

[N ]T [ fb]dV

)
+{qe }T

(∫
Se

[N ]T [ fs]dS

)
(3.13)

onde a integração superficial é realizada somente para elementos na região de aplicação da

força do domínio do problema. Considerando:

[Fb] =
∫

Ve

[N ]T [ fb]dV (3.14)

[Fs] =
∫

Se

[N ]T [ fs]dS (3.15)

A equação 3.13 pode ser rescrita como:

W f = {qe }T [Fb]+ {qe }T [Fs] = {qe }T [ fe ] (3.16)

onde [Fb] e [Fs] são às forças nodais atuando nos nós do elemento, que são equivalentes as

forças estruturais e superficiais aplicadas nos elementos em termos do trabalho realizado no

deslocamento virtual. As duas forças nodais podem ser somadas para formar a força nodal

total [ fe ]:

[ fe ] = [Fb]+ [Fs] (3.17)

Substituindo as equações 3.12, 3.16 e 3.9 na função lagrangiana L, tem-se:

L = 1

2
{q̇e }T [me ]{q̇e }− 1

2
{qe }T [ke ]{qe }+ {qe }T [ fe ] (3.18)
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Aplicando o princípio de Hamilton (eq. 3.2), tem-se:

δ

∫ t2

t1

(
1

2
{q̇e }T [me ]{q̇e }− 1

2
{qe }T [ke ]{qe }+ {qe }T [ fe ]

)
dt = 0 (3.19)

Como a variação e os operadores de integração são independentes, obtém-se:∫ t2

t1

(
δ{q̇e }T [me ]{q̇e }−δ{qe }T [ke ]{qe }+δ{qe }T [ fe ]

)
dt = 0 (3.20)

Na equação 3.20, a variação e a diferenciação com o tempo são independentes, i.e.:

δ{q̇e }T = δ
(

d{qe }T

dt

)
= d

dt

(
δ{qe }T )

(3.21)

Substituindo a equação 3.21 na equação 3.20, e integrando por partes o primeiro termo,

obtém-se:∫ t2

t1

δ{q̇e }T [me ]{q̇e }dt = δ{q̇e }T [me ]{q̇e }|t2
t1︸ ︷︷ ︸

=0

−
∫ t2

t1

δ{qe }T [me ]{q̈e }dt =−
∫ t2

t1

δ{qe }T [me ]{q̈e }dt

(3.22)

Substituindo a equação 3.22 em 3.20, tem-se:∫ t2

t1

δT
e

(−[me ]{q̈e }− [k]{qe }+ [ fe ]
)

dt = 0 (3.23)

Na equação 3.23, como a integração resulta em zero, pode-se remover o integrando, e divi-

dindo por δ{qe }T , resulta em:

[ke ]{qe }+ [me ]{q̈e } = { fe } (3.24)

A equação 3.24 é a equação do método de elementos finitos para um elemento, onde [ke ]

e [me ] são as matrizes de rigidez e massa para um elemento, e { fe } é o vetor de força total

atuando nos nós do elemento.

A equação 3.24 é referente a um sistema de coordenadas locais, para transformar em um

sistema de coordenadas global, usam-se variáveis globais, fazendo a transformação obtêm-

se:

[Ke ][Qe ]+ [Me ][Q̈e ] = [Fe ] (3.25)

A equação 3.25 é a equação governante do movimento na forma matricial para um ele-

mento no sistema de coordenadas global. Para gerar a equação governante do movimento

de todo o domínio deve-se somar as equações de cada elemento para gerar a equação do

movimento de todo o domínio. Somando os todos os elementos da equação 3.25, temos:

[K ][Q]+ [M ][Q̈] = [F ] (3.26)

Onde:
[K ] =∑

n[Ke ]

[M ] =∑
n[Me ]

[F ] =∑
n[Fe ]

onde n são os n elementos que compõem o domínio.
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4 Otimização usando o ANSYS

Nesse capítulo apresenta-se o software comercial ANSYS, um dos mais utilizados na in-

dústria para modelagem e simulação de problemas estruturais e outros de Engenharia Me-

cânica, com destaque para seu uso em otimização de estruturas.

4.1 Histórico da otimização no ANSYS

A otimização estrutural no ANSYS iniciou-se com o uso da ferramenta ANSYS Mechanical

APDL, em que, por meio da utilização da linguagem paramétrica, era possível criar rotinas

que realizavam a otimização de estruturas, aliando o MEF a métodos de otimização.

Devido à complexidade de se realizar otimização utilizando a linguagem paramétrica,

surgiram ferramentas para o ANSYS Mechanical APDL como o módulo de otimização, com

o qual era possível realizar otimização paramétrica usando alguns métodos disponíveis na

ferramenta.

Com o surgimento do ANSYS Workbench, que possuí uma interface mais amigável e de

fácil uso, foram integradas ferramentas ao ANSYS Workbench como o Design Exploration,

que permite realizar otimização paramétrica, de forma e topológica. Em certo momento, o

ANSYS Workbench com a ferramenta Design Exploration se tornou a principal ferramenta

de otimização e as funções de otimização pelo ANSYS Mechanical APDL foram desconti-

nuadas a partir da versão 19.0, sendo possível realizar otimização somente pela linguagem

paramétrica.

Em 2019, a ANSYS adquiriu a Dinardo, passando a ter em seu catálogo o software Op-

tiSlang, que realiza otimização robusta de conceito e análise estocástica em CAE, sendo um

software que consegue realizar os principais tipos de otimização estrutural. Outro software

que realiza otimização é o ANSYS Discovery, contudo, ele realiza somente otimização topo-

lógica.

4.2 O ANSYS

O ANSYS é um software de elementos finitos que tem aplicação nas diversas classes de

problemas de engenharia. O ANSYS inclui habilidades para resolver sete tipos de análises es-

truturais disponíveis. A análise estrutural utiliza nós com graus de liberdade, que permitem

calcular os parâmetros de deslocamento e rotação. Dos deslocamentos nodais derivam-se

quantidades como deformações, tensões e forças de reação.

Os sete tipos de análise estrutural que podem ser executadas são:
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• Análise estática: usada para determinar, sob condição de carga estática, deslocamen-

tos, tensões, entre outros. A análise estática pode ser linear ou não-linear, sendo que

as não linearidades podem incluir plasticidade, tensão, rigidez, grandes deformações,

grandes tensões, hiper-elasticidade, superfície de contato e fissuração;

• Análise modal: usada para calcular as frequências naturais e modos de vibração de

uma estrutura. Há diferentes métodos disponíveis de extração de modos;

• Análise harmônica: usada para determinar a resposta de uma estrutura a cargas harmô-

nicas variáveis no tempo;

• Análise dinâmica transiente: usada para determinar a resposta de uma estrutura a car-

gas arbitrariamente variáveis no tempo;

• Análise espectral: é uma extensão da análise modal, usada para calcular as tensões e

deformações devidas a um espectro de resposta ou uma contribuição de PSD (vibra-

ções aleatórias);

• Análise de Flambagem: usada para calcular as cargas de flambagem e determinar a

forma do modo de flambagem. Permite a análise de flambagem linear e não-linear;

• Análise dinâmica explícita: usado para calcular soluções rápidas para cargas dinâmi-

cas, grandes deformações e complexos problemas de contato.

O ANSYS divide a análise estrutural em três etapas, pré-processamento, processamento

(solução) e pós-processamento. Após realizada a análise estática e/ou dinâmica podem-se

usar as ferramentas de otimização.

4.3 As diferentes ferramentas de otimização do ANSYS

Como existem diferentes pacotes do software ANSYS, que conseguem realizar otimiza-

ção estrutural, serão mencionadas as formas de otimização utilizando o ANSYS Mechanical

APDL e usando o ANSYS Workbench. De maneira geral, as ferramentas de otimização do

ANSYS empregam três tipos de parâmetros que caracterizam o processo:

• Variáveis de projeto (DV): são variáveis independentes que variam dentro de limites

especificados para alcançar o resultado ótimo. Os limites superior e inferior são as

restrições das variáveis de projeto.

• Variáveis de estado (SV): são variáveis de resposta, funções dependentes das variáveis

de projeto, sendo as restrições do projeto. Podem ter limite máximo e mínimo ou ape-

nas um limite.
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• Função objetivo (OF): é uma variável dependente, que é função das variáveis de pro-

jeto. Busca-se na função objetivo, minimizar ou maximizar o valor da variável. Nos

problemas de otimização do ANSYS, dependendo do método escolhido podem-se de-

finir múltiplas funções objetivo.

4.3.1 Módulo de otimização

O processo de otimização no ANSYS Mechanical APDL é feito por meio de um módulo,

que como condição de uso, deve ter concluída a análise estática e/ou dinâmica da estrutura.

O módulo de otimização tem como objetivo determinar um projeto ótimo, minimizando ou

maximizando os parâmetros de projeto, satisfazendo as restrições impostas no projeto ini-

cial.

As variáveis são representadas por meio de parâmetros escalares em uma linguagem pa-

ramétrica de projeto ANSYS APDL.

O módulo de otimização do ANSYS utiliza técnicas matemáticas que integram o ciclo de

projeto manual, gerando um processo iterativo computadorizado. Os processos são repeti-

dos até que se alcance o projeto ótimo. O processo se inicia definindo parâmetros iniciais,

que incluem as variáveis de projeto, variáveis de estado e a função objetivo, sendo esses va-

lores modificados durante o processo de otimização.

O módulo de otimização necessita que se tenha concluída a etapa de análise estrutural

estática e/ou dinâmica, pois a rotina gerada na análise estrutural será utilizada no módulo

de otimização. Como mostrado na figura 4.1, o processo de otimização consiste em obter

uma solução inicial, essa solução gera um arquivo de dados (file.db). Com esse arquivo de

dados inicia-se o módulo de otimização, onde são aplicados as restrições e os limites de oti-

mização. Executando a otimização, o arquivo de dados da primeira solução é iterado, até

alcançar o resultado ótimo, que é o resultado que está o mais próximo dos limites e restri-

ções aplicados no módulo de otimização.

4.3.2 Direct Optimization

No ANSYS Workbench, dentro das ferramentas disponíveis do design exploration, o mó-

dulo Direct Optimization é uma das ferramentas que permite otimização paramétrica.

O módulo Direct Optimization pode ser utilizado após realizada a análise estrutural, pois

o módulo utiliza a análise estrutural para obter as variáveis de estado do problema, as con-

dições iniciais e a análise como parte do processo de otimização, pois os parâmetros de de-

senho serão alterados e serão modificados os resultados da análise estrutural, conforme se
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Figura 4.1 – Estrutura do processo de otimização no ANSYS APDL[1].

desenvolve o processo de otimização.

A análise estrutural é realizada pelo ANSYS Mechanical, enquanto o módulo Direct Op-

timization é externo ao ANSYS Mechanical, sendo uma ferramenta do ANSYS Workbench,

porém no fluxograma do projeto no ANSYS Workbench são mostrados os parâmetros de

projeto que são ligados ao módulo, que utiliza os parâmetros interligando as ferramentas

disponíveis de forma a obter a solução otimizada.

Na figura 4.2, apresenta-se a estrutura de um processo de otimização simples, onde

ocorre a análise estrutural, que gera os parâmetros de entrada e saída; depois tem-se a inter-

ligação do módulo Direct Optimization, que utiliza os parâmetros de entrada e saída, além

da análise estrutural, para gerar o processo de otimização, visando obter o melhor resultado

possível dos parâmetros de entrada, dentro das restrições impostas.
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Figura 4.2 – Estrutura do processo de otimização no Workbench.

4.4 Tipos de Otimização

4.4.1 Módulo de Otimização

O ANSYS Mechanical APDL tem diferentes métodos para otimização, os métodos descri-

tos abaixo são apresentados pelo manual avançado do ANSYS[1].

4.4.1.1 Método de aproximação por subproblema

O método de aproximação por subproblema é um método de ordem zero que utiliza

aproximações para todas as variáveis dependentes (variáveis de estado e função objetivo). O

programa faz a relação das variáveis de estado com a função objetivo por meio de ajuste de

curva. O cálculo é feito usando a função objetivo para diferentes conjuntos de valores das

variáveis de projeto e realizando mínimos quadrados entre os dados.

As variáveis de estado e os limites das variáveis de projeto são as restrições do problema

e tornam o problema de otimização restrito. Porém o programa converte o problema em

um problema de otimização irrestrito, através da adição de penalidades na aproximação da

função objetivo devido as restrições impostas. O programa realiza essa conversão pois as

técnicas de minimização que serão usadas posteriormente se tornam mais eficientes.

A busca pela minimização da aproximação da função objetivo irrestrita é feita aplicando

a técnica de minimização sequencial irrestrita[9] em cada iteração. É interessante observar

que como o método se baseia em aproximações, quanto mais próximo à solução inicial for

da solução final, mais precisos serão os resultados obtidos.



Capítulo 4. Otimização usando o ANSYS 22

4.4.1.2 Método de primeira ordem

O método de primeira ordem faz a conversão do problema em um problema irrestrito

adicionando funções de penalidade para a função objetivo, porém difere do método de apro-

ximação por subproblema por minimizar a representação do elemento finito ao invés de ser

uma aproximação.

O método utiliza gradientes das variáveis dependentes com respeito as variáveis de pro-

jeto. Para cada iteração, são calculados gradientes que determinam uma linha de pesquisa,

que leva a minimização do problema irrestrito. Além disso, cada iteração é composta de um

número de sub-iterações, que incluem pesquisa de direção e computação dos gradientes,

fazendo com que uma iteração tenha várias análises em loop.

É interessante observar que o método de primeira ordem pode convergir para um re-

sultado inviável, pois o programa pode encontrar um mínimo local ou simplesmente não

existem soluções viáveis. Nesse caso é recomendado usar o método de aproximação por

subproblema.

4.4.2 Direct Optimization

O ANSYS Workbench com sua ferramenta Direct Optimization tem diferentes métodos

de otimização, onde os métodos são apresentados abaixo:

4.4.2.1 Screening

O método de otimização screening é uma abordagem de otimização que usa amostragem

e ordenação para obter os resultados otimizados. O método não é muito eficiente, por isso é

mais utilizado para obtenção de resultados preliminares, para em seguida ser utilizado um

método para obtenção de resultados mais refinados. O método tem a vantagem de permitir

múltiplas funções objetivo e restrições, bem como todos os tipos de parâmetros de entrada

possíveis.

4.4.2.2 Multi-Objective Genetic Algorithm (MOGA)

O método MOGA é uma variante do popular NSGA-II (Non-Dominated Sorted Genetic

Algorithm-II) baseado em conceitos de elitismo controlado. Ele suporta várias funções ob-

jetivo e restrições, e visa encontrar o ótimo global.

4.4.2.3 Nonlinear Programming by Quadratic Lagrangian (NLPQL)

O método NLPQL é um algoritmo baseado em gradiente para fornecer um resultado de

otimização local e refinado. Ele suporta um único objetivo, várias restrições e é limitado a
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parâmetros contínuos. O ponto de partida deve ser especificado para determinar a região

do espaço de design a ser explorado.

4.4.2.4 Mixed-Integer Sequential Quadratic Programming (MISQP)

O método MISQP resolve problemas de programação não linear inteira mista por um

método de programação quadrática sequencial modificado. Partindo do pressuposto de que

as variáveis inteiras têm uma influência suave nas funções do modelo, ou seja, os valores da

função não mudam drasticamente quando aumentam ou diminuem uma variável inteira,

aproximações quadráticas sucessivas são aplicadas. Ele suporta um único objetivo e várias

restrições. O ponto de partida deve ser especificado para determinar a região do espaço de

design a ser explorado.

4.4.2.5 Adaptative Single-Objective

O método Adaptative Single-Objective é uma variante do popular NSGA-II (Non-Dominated

Sorted Genetic Algorithm-II) baseado em conceitos de elitismo controlado. Ele suporta so-

mente uma função objetivo e múltiplas restrições, e visa encontrar o ótimo global. Porém é

limitado à parâmetros de entrada contínuos e manufaturáveis.

4.4.2.6 Adaptative Multi-Objective

O método Adaptative Multi-Objective também é uma variante do popular NSGA-II (Non-

Dominated Sorted Genetic Algorithm-II) baseado em conceitos de elitismo controlado. Ele

suporta várias funções objetivo e restrições, e visa encontrar o ótimo global. Porém é limi-

tado à parâmetros de entrada contínuos e manufaturáveis.

4.5 Problema de otimização

Para apresentar o procedimento de otimização usando o ANSYS, foi considerou-se um

exemplo de aplicação disponibilizado pela Universidade de Alberta [10]. Contudo esse exem-

plo foi melhorado e atualizado de maneira a incluir os comandos e tipos de elementos mais

atuais do ANSYS. O exemplo considerado é apresentado na figura 4.3, onde se tem uma viga

de seção quadrada de 1 m, com uma força aplicada de 2000 N. Como restrições impostas foi

considerado que a viga não pode exceder uma tensão máxima de 200 MPa e a altura/largura

não pode ser menor que 10 mm. A viga é feita de aço e tem módulo de elasticidade de 200

GPa.

O problema da viga é de otimização paramétrica, pois objetiva-se obter a menor área de

seção transversal da viga, dentro das restrições apresentadas, sem alterar a forma da viga,

somente alterando as dimensões da mesma (Cf. seção2.2).
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F = 2000 N

L = 1000 mm

H

W

L = 750 mm

Figura 4.3 – Problema de viga com seção transversal quadrada

4.5.1 ANSYS Mechanical APDL

Para implementar a otimização do problema no ANSYS Mechanical APDL, será dividido

o processo em 4 etapas, sendo elas o pré processamento, o processamento (solução), pós

processamento e design optimization (módulo de otimização).

Pré processamento

No pré processamento (/PREP7) será definida a estrutura a ser otimizada, apresentando

o tipo de elemento, suas propriedades, dimensões, características e gerando a malha. Para

implementação do pré processamento, será utilizada a interface gráfica do ANSYS APDL, a

GUI (Guide User Interface).

Para realizar a otimização paramétrica da estrutura, definem-se como parâmetros a al-

tura (H) e a largura (W), que serão as variáveis a serem otimizadas. Para isso:

• Selecionar: Utility Menu > Parameters > Scalar Parameters

• Ao selecionar Scalar Parameters aparecerá a janela da figura 4.4, em Selection será

inserido o parâmetro W=20 (largura) e para salvar será selecionado Accept

• Ainda em Scalar Parameters será inserido o parâmetro H=20 (altura), para salvar será

selecionado Accept e em seguida pode ser fechado a janela selecionando Close.

Será definido o tipo de elemento que será analisado, no caso o elemento que será se-

lecionado é o BEAM188, que é um elemento tridimensional, baseado na teoria de viga de

Timoshenko. Para selecionar o elemento:

• Selecionar: Main Menu > Preprocessor > Element Type > Add

• Ao selecionar Add aparecerá a janela do lado esquerdo apresentada na figura 4.5, aqui

são apresentados os elementos que compõem a estrutura, para adicionar um elemento

seleciona-se Add
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Figura 4.4 – Janela de parâmetros escalares

Figura 4.5 – Seleção do elemento BEAM188

• Após selecionar Add aparecerá a janela à esquerda na figura 4.5. Aqui têm-se os vá-

rios tipos de elementos possíveis, para selecionar o BEAM188, seleciona-se: Structural

Mass > Beam > 3D finite strain > 2 node 188, em seguida seleciona-se OK e Close

Após definir o elemento, devem-se definir suas propriedades, para isso:

• Selecionar: Main Menu > Preprocessor > Material Props > Material Models

• Ao selecionar Material Models aparecerá a janela a esquerda apresentada na figura

4.6, onde seleciona-se: Structural > Linear > Elastic > Isotropic
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Figura 4.6 – Definição das propriedades da viga

• Ao selecionar Isotropic aparecerá a janela à direita na figura 4.6, onde EX é o módulo

de Young e PRXY é o coeficiente de Poisson, em EX será adicionado 200000 e em PRXY

será adicionado 0.3. Em seguida seleciona-se OK.
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Deve-se gerar a estrutura a ser otimizada criando os nós, no problema serão gerados 3

nós, para isso:

• Selecionar: Main Menu > Preprocessor > Modeling > Create > Keypoints > In Active

CS

• Ao selecionar In Active CS aparecerá a janela apresentada na figura 4.7, em NPT será

definido o número do nó, em X,Y,Z será inserido a posição das variáveis, onde:

Nós Coordenadas (x,y)
1 (0,0)
2 (750,0)
3 (1000,0)

Figura 4.7 – Criação dos nós principais

• Inserindo a coordenada do nó 1, seleciona-se Apply, repete-se o processo para a coor-

denada do nó 2 e 3 e seleciona-se OK.

Definidos os nós da estrutura, serão geradas duas linhas ligando os nós 1, 2 e 3. Para

gerar a linha será feito:

• Selecionar: Main Menu > Preprocessor > Modeling > Create > Lines > Lines > In

Active Coord

• Ao selecionar In Active Coord aparecerá a janela apresentada na figura 4.8, para gerar

a linha será selecionado o nó 1 e o nó 2 utilizando o cursor, formando a linha 1 e será

selecionado o nó 2 e o nó 3 utilizando o cursor, formando a linha 2, será selecionado

OK

Após definir os nós da estrutura, será definida a área da seção transversal:

• Selecionar: Main Menu > Preprocessor > Sections > Beam > Common Sections
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Figura 4.8 – Criação de linhas

• Ao selecionar Common Sections aparecerá a janela apresentada na figura 4.9, onde

serão definidas as dimensões da seção transversal. Em Offset To será selecionado Cen-

troid, isso define que o ponto central da área de seção transversal está localizado no

centro, H é a espessura da seção onde será definido como W e B é a altura da seção

onde será definido como H. Em seguida seleciona-se OK.
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Figura 4.9 – Definição da área de seção transversal da viga

Vale mencionar que B na seção transversal da viga está na direção y e H na direção z,

como a força aplicada está na direção y , a altura da viga será B enquanto H será a largura.

Para gerar novos elementos a partir das linhas para criar uma malha:

• Selecionar: Main Menu > Preprocessor > Meshing > Size Cntrls > ManualSize > Li-

nes > Picked Lines

• Ao selecionar Picked Lines aparecerá a janela apresentada na figura 4.10 à esquerda,

ao selecionar as linhas, seleciona-se OK.

• Ao selecionar OK aparecerá a janela apresentada na figura 4.10 à direita, em NVID

insira 10, com isso as linhas serão divididas em 10 elementos e seleciona-se OK.
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Figura 4.10 – Divisão da linha em elementos

Para gerar a malha, a partir dos elementos gerados anteriormente:

• Selecionar: Main Menu > Preprocessor > Meshing > Mesh > Lines

• Ao selecionar Lines aparecerá a janela apresentada na figura 4.11, ao selecionar as

linhas, seleciona-se OK.

Figura 4.11 – Definição da malha em linha

Ao definir a malha, deve-se inserir o comando FINISH, para concluir a etapa de pré-

processamento.
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Processamento

O processamento ou solução (/SOLU) é a etapa onde são definidas as restrições da estru-

tura, o tipo de análise a ser realizada e as forças aplicadas. Para iniciar o módulo de solução

deve-se inserir o comando /SOLU.

Para aplicar as restrições nos nós 1 e 3 da estrutura, serão inseridos os seguintes coman-

dos:

DK,1,UX,0

DK,1,UY,0

DK,3,UY,0

Onde DK é o termo que indica a aplicação de um deslocamento no nó, o termo após a pri-

meira virgula é o número do nó, o termo após a segunda virgula é a direção do deslocamento

e o termo após a última vírgula é a quantidade de deslocamento, nesse caso é zero, pois

deseja-se restringir o movimento nas direções x e y para o nó 1 e na direção x para o nó 3.

Como o problema tem força aplicada somente na direção y e restrições nas direções x

e y , podemos assumir o problema como bidimensional. Porém o elemento BEAM188 pos-

sui 6 graus de liberdade, incluindo translação nas direções x, y e z, bem como rotações nas

direções x, y e z, assim para que o problema esteja definido com relação as condições de

contorno, será necessário restringir os movimentos na direção z e rotações nas direções x e

y .

Para isso serão utilizados os seguintes comandos:

NSEL,ALL

D,ALL,UZ,0

D,ALL,ROTX,0

D,ALL,ROTY,0

Onde o primeiro comando seleciona todos os nós da estrutura, para que nos comandos

seguintes seja aplicado a restrição de deslocamento na direção z e rotações x e y .

Para aplicar a força, será utilizado o seguinte comando:

FK,2,FY,-2000

Onde o comando indica que na direção y do nó 2, será aplicado uma força de 2000 N para

baixo.
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Com isso, o problema está completamente definido em termos de estrutura, proprieda-

des e condições de contorno. Para solucionar o problema será selecionado o tipo de análise:

• Selecionar: Main Menu > Solution > Analysis Type > New Analysis

• Ao selecionar New Analysis aparecerá a janela apresentada na figura 4.12, seleciona-se

Static para o tipo de análise e seleciona-se OK.

Figura 4.12 – Seleção do tipo de análise estrutural

Definido o tipo de análise, será solucionado o problema, para isso:

• Selecionar: Main Menu > Solution > Solve > Current LS

• Ao selecionar Current LS aparecerá a janela apresentada na figura 4.13 e seleciona-se

OK.

• Se o problema estiver bem definido, como resultado será apresentado uma janela anun-

ciando que o problema foi solucionado e sem mensagens de erro.

Figura 4.13 – Etapa de solução

Pós Processamento

Na etapa de pós processamento serão visualizados os resultados obtidos na etapa de

solução. Para o problema, busca-se obter a tensão máxima na viga e o volume. Para obter o

volume:



Capítulo 4. Otimização usando o ANSYS 33

• Selecionar: General Postproc > Element Table > Define Table

• Ao selecionar Define Table aparecerá a janela apresentada na figura 4.14 a esquerda e

seleciona-se Add.

• Ao selecionar Add aparecerá a janela apresentada na figura 4.14 a direita, em AVPRIN

será inserido 0, em Lab será inserido EVolume, em item será selecionado Geometry e

Elem volume VOLU, em seguida OK.

Figura 4.14 – Obtenção do volume de cada elemento

O volume que foi obtido é de cada elemento, para obter o volume da viga será necessário

somar os volumes, para isso:

• Selecionar: General Postproc > Element Table > Sum of Each Item

• Ao selecionar Sum of Each Item aparecerá a janela que irá calcular a soma do volume,

pressione OK.

Com isso será exibido o volume da estrutura que será de 400000 mm2.

Para salvar o volume como uma variável:

• Selecionar: Utility Menu > Parameters > Get Scalar Data ...

• Ao selecionar Get Scalar Data ... aparecerá a janela apresentada na figura 4.15 a es-

querda e seleciona-se Results data e Elem table sums e por fim seleciona-se OK.

• Ao selecionar OK aparecerá a janela apresentada na figura 4.15 a direita, onde será

colocado Volume como nome do parâmetro e o elemento será EVOLUME, em seguida

seleciona-se OK.

Com isso o volume terá sido adicionado como um parâmetro. O próximo parâmetro a ser

obtido é a máxima tensão na viga.

Para isso, primeiro será obtida a tensão no i-ésimo nó de cada elemento:

• Selecionar: General Postproc > Element Table > Define Table... > Add
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Figura 4.15 – Obtenção do volume total

• Ao selecionar Add aparecerá a janela apresentada na figura 4.16, onde em AVPRIN será

inserido 0, em Lab será inserido SBYB_I, em item será selecionado By sequence num

e SMISC, e após a virgula será adicionado o número 33, por fim seleciona-se OK.

Figura 4.16 – Definição da tensão no i-ésimo nó

Para uma viga com força aplicada na direção y , a maior tensão será de flexão, por isso o nú-

mero usado foi o 33, que indica a tensão de flexão no i-ésimo nó para o elemento BEAM188.

Para encontrar a máxima tensão atuante na estrutura, será feito:

• Selecionar: General Postproc > List Results > Sorted Listing > Sort Elems

• Ao selecionar Sort Elems aparecerá a janela apresentada na figura 4.17, onde será pre-

enchido como está na figura.

Com isso os valores de tensão salvos em SBYB_I serão colocados em ordem decrescente.

Para salvar a máxima tensão no i-ésimo nó como um parâmetro, será feito:

• Selecionar: Utility Menu > Parameters > Get Scalar Data...

• Ao selecionar Get Scalar Data... aparecerá uma janela onde será selecionado Results

Data e Others.

• Ao selecionar Others aparecerá a janela da figura 4.18, onde o nome do parâmetro será

SBYBI, será selecionado From sort oper’n e Maximun Value, em seguida OK.
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Figura 4.17 – Organização em ordem decrescente da tensão no i-ésimo nó

Figura 4.18 – Obtenção da máxima tensão

Para obter a máxima tensão no j-ésimo nó, serão repetidos os mesmos passos que foram

executados para a máxima tensão no i-ésimo nó, porém com pequenas alterações. Para

obter as tensões:

• Selecionar: General Postproc > Element Table > Define Table... > Add

• Aqui o processo será o mesmo para o i-ésimo nó, porém em Lab será inserido SBYB_J

(ao invés de SBYB_I) e o número será 38.

Para selecionar os nós em ordem decrescente será o mesmo processo da tensão no i-ésimo

nó, porém em Item, Comp será selecionado SBYB_J.

Para salvar a máxima tensão no j-ésimo nó como um parâmetro será feito o mesmo processo

do i-ésimo nó, porém o nome do parâmetro será SBYBJ.

Para selecionar o maior entre SBYBI e SBYBJ será usado o comando:

*SET,SBYB,SBYBI>SBYBJ

Isso se faz necessário pois nem sempre ambos serão iguais.

Módulo de otimização
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Ao realizar a solução do problema e obter as variáveis necessárias para a otimização,

necessita-se salvar os passos do processo, pois os passos realizados anteriormente serão re-

alizados várias vezes em um processo iterativo no intuito de obter uma estrutura otimizada.

Para salvar os passos anteriores em arquivo de texto:

• Selecionar: Utility Menu > File > Write DB Log File...

• Aparecerá uma janela onde no nome do arquivo será inserido ’optimize.txt’, depois

seleciona-se OK.

É importante lembrar onde foi salvo o arquivo de texto, pois esse arquivo ainda não está

pronto para ser usado na otimização, ele terá de ser tratado, pois ao utilizar a interface visual

são gerados comandos adicionais que interagem com a interface que não são necessários

no processo de otimização.

Como resultado, o arquivo ’optimize.txt’ apresentará:

/BATCH

! /COM,ANSYS RELEASE Release 18.1 BUILD 18.1 UP20170403 10:14:51

/input,menust,tmp,”

! /GRA,POWER

! /GST,ON

! /PLO,INFO,3

! /GRO,CURL,ON

! /CPLANE,1

! /REPLOT,RESIZE

WPSTYLE„„„„0

! /REPLOT,RESIZE

*SET,W,20

*SET,H,20

/PREP7

!*

ET,1,BEAM188

!*

!*

MPTEMP„„„„

MPTEMP,1,0

MPDATA,EX,1„200000

MPDATA,PRXY,1„0.3

K,1,0,0„

K,2,750,0„

K,3,1000,0„

L,1,2

L,2,3

SECTYPE,1,BEAM,RECT„0
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SECOFFSET, CENT

SECDATA,H,W,0,0,0,0,0,0,0,0,0,0

FLST,5,2,4,ORDE,2

FITEM,5,1

FITEM,5,-2

CM,_Y,LINE

LSEL, , , ,P51X

CM,_Y1,LINE

CMSEL„_Y

!*

LESIZE,_Y1, , ,10, , , , ,1

!*

FLST,2,2,4,ORDE,2

FITEM,2,1

FITEM,2,-2

LMESH,P51X

FINISH

/SOLU

DK,1,UX,0

DK,1,UY,0

DK,3,UY,0

NSEL,ALL

D,ALL,UZ,0

D,ALL,ROTX,0

D,ALL,ROTY,0

FK,2,FY,-2000

!*

ANTYPE,0

! /STATUS,SOLU

SOLVE

FINISH

/POST1

AVPRIN,0,0,

ETABLE,EVolume,VOLU,

!*

SSUM

!*

*GET,Volume,SSUM, ,ITEM,EVOLUME

AVPRIN,0,0,

ETABLE,SBYB_I,SMISC, 33

!*
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ESORT,ETAB,SBYB_I,0,1, ,

!*

*GET,SBYBI,SORT„MAX

AVPRIN,0,0,

ETABLE,SBYB_J,SMISC, 38

!*

ESORT,ETAB,SBYB_J,0,1, ,

!*

*GET,SBYBJ,SORT„MAX

*SET,SBYB,SBYBI>SBYBJ
! LGWRITE,’optimize’,’txt’,’C:\’,COMMENT

Após a limpeza do arquivo, o arquivo ficou:

*SET,W,20

*SET,H,20

/PREP7

ET,1,BEAM188

MP,EX,1,200000

MP,PRXY,1,0.3

K,1,0,0„

K,2,750,0„

K,3,1000,0„

L,1,2

L,2,3

SECTYPE,1,BEAM,RECT„0

SECOFFSET,CENT

SECDATA,H,W,

LESIZE,ALL„,10

LMESH,ALL

FINISH

/SOLU

DK,1,UX,0

DK,1,UY,0

DK,3,UY,0

NSEL,ALL

D,ALL,UZ,0

D,ALL,ROTX,0

D,ALL,ROTY,0

FK,2,FY,-2000

ANTYPE,0

SOLVE
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FINISH

/POST1

ETABLE,EVolume,VOLU,

SSUM

*GET,Volume,SSUM„ITEM,EVOLUME

ETABLE,SBYB_I,SMISC,33

ESORT,ETAB,SBYB_I,0,1„

*GET,SBYBI,SORT„MAX

ETABLE,SBYB_J,SMISC,38

ESORT,ETAB,SBYB_J,0,1„

*GET,SBYBJ,SORT„MAX

*SET,SBYB,SBYBI>SBYBJ
! LGWRITE,’optimize’,’txt’,’C:\’

Agora o arquivo está pronto para ser lido pelo módulo de otimização, para iniciar o modulo de

otimização será inserido na linha de comando /OPT.

O arquivo ’optimize.txt’ será usado como forma de repetir o processo feito anteriormente para cada

iteração dos parâmetros de otimização. Para o módulo de otimização ler o arquivo deverá ser inserido

na linha de comando:

OPANL,’optimize’,’txt’,’C:\’

Onde oOPANL define o arquivo de análise que será usado no processo de otimização, após a primeira

vírgula tem-se o nome do arquivo e o diretório do mesmo.

Agora serão definidas as variáveis de otimização, que são apresentadas na seção 4.3, as variáveis de

projeto são a altura H e a largura W, a variável de estado é a tensão e a função objetivo é o volume.

Para definir as variáveis deverão ser inseridas na linha de comando:

OPVAR,W,DV,10,50,0.001

OPVAR,H,DV,10,50,0.001

OPVAR,SBYB,SV,195,200,0.001

OPVAR,VOLUME,OBJ„,200

Onde a primeira e segunda linha definem as variáveis de projeto, com variação entre 10 mm e

50 mm, com tolerância de 0,001 mm. A terceira linha define a tensão como variável de estado, com

mínimo de 195 MPa e máximo de 200 MPa, com tolerância de 0,001 MPa. A quarta linha define o

volume como função objetivo, com tolerância de 200 mm3.

Definidas as variáveis de otimização, deve-se definir o método de otimização, para isso deve ser

inserido na linha de comando:

OPTYPE,SUBP

OPSUBP,30,7
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O método de otimização escolhido foi o de subproblem approximation, com máximo de 30 iterações

e 7 designs inviáveis.

Para iniciar a otimização será inserido o comando OPEXE.

4.5.2 ANSYS Workbench

Para gerar a análise estática, seleciona-se static structural e como mostrado na figura 4.2, pri-

meiramente deve-se definir o material da estrutura, para o problema da viga o material é o aço, para

selecionar o aço:

• Selecionar: engineering data no project schematic.

• O material padrão é o aço estrutural, mas caso não seja, deve-se entrar em engineering data

sources, entrar em General Materials e adicionar um dos materiais da lista.

Figura 4.19 – Seleção de material da estrutura

Em seguida é necessário definir a geometria do problema, para isso tem-se duas opções de cria-

ção de geometria: usando o DesignModeler ou o SpaceClaim. O DesignModeler é um programa de

criação de geometria CAE mais antigo, sendo mais complexo seu uso para geometrias que deman-

dem posições fora dos planos xy, zx e yz, o SpaceClaim em contrapartida é mais simples de criar

geometrias, além de ser fácil de adicionar peças feitas em programas CAD como o SolidWorks, porém

tem certa dificuldade com corpos de linha, pois há casos em que esses acabam sendo unificados ao

serem enviados ao ANSYS Mechanical para realizar a análise.

Nesse problema foi utilizado o SpaceClaim para gerar a geometria, como apresentado na figura 4.20.

Para gerar a geometria deve-se:

• Selecionar Sketch Mode, em seguida selecionar o plano de desenho, no problema foi utilizado

o plano XY.
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• Selecionar Line e gerar duas linhas, uma com 750 mm e outra com 250 mm.

• Para tornar as linhas uma viga com área, seleciona-se na barra de ferramentas Prepare, em

seguida Perfis e seleciona em New Profile Library a forma da área, no problema foi um retân-

gulo.

• Para alterar as dimensões da área criada, em Structure>Beam Profiles aparece o perfil criado,

ao usar o botão direito do mouse no perfil, seleciona-se Edit Beam Profile, onde será possível

mudar as dimensões do perfil, que serão 20 mm x 20 mm.

• Para aplicar o perfil nas linhas seleciona-se as linhas e em Prepare aparecerá o perfil criado e

é só selecionar esse perfil que as linhas terão uma área.

É importante lembrar que é necessário ativar a opção Share em Share Topology nas propriedades

da geometria, pois caso não seja ativada tal opção, no ANSYS Mechanical as linhas estarão desconec-

tadas, sendo necessário conectá-las usando contatos. Ao ativar essa opção, as linhas estarão ligadas

quando a geometria for transferida para o ANSYS Mechanical. As geometrias geradas usando perfil

normalmente são elementos-tipo BEAM188, que para o problema é o elemento ideal.

Figura 4.20 – Geometria da viga no SpaceClaim

Em seguida, será gerada a malha, para isso em Project Schematic seleciona-se Model, com isso

será levado ao ANSYS Mechanical, onde para gerar a malha:

• Seleciona-se Mesh>Insert>Sizing, com isso seleciona-se a geometria e o tipo de divisão da

malha, no caso foi selecionado o número de divisões sendo 10.

• Para gerar a malha seleciona-se Generate Mesh.

Ainda no ANSYS Mechanical será necessário definir as forças e restrições para realizar a análise

estática, para isso:
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• Seleciona-se Static Structural>Insert>Fixed Support e o nó que será fixado, que será o nó na

extremidade esquerda.

• Seleciona-se Static Structural>Insert>Displacement e o nó que será travado, que será o nó

na extremidade direita, porém somente as direções y e z que serão restringidas.

• Seleciona-se Static Structural>Insert>Force e a força será aplicada no nó que liga as duas

partes da viga, onde a força que será aplicada será de -2000 N.

Após aplicado as forças e restrições nos nós, será realizada a análise estática selecionando Solve,

se não houver nenhuma mensagem acusando erro, falha por problemas de má definição das forças

e restrições, então pode-se obter as tensões na viga, para isso seleciona-se Solution>Insert>Beam

Tool>Beam Tool, com isso serão resgatadas a tensão máxima e miníma combinada, além da tensão

axial, porém para obter esses dados será necessário selecionar Solution>Evaluate All Results, como

mostrado na figura 4.21.

Figura 4.21 – Tensão combinada na viga

Realizada a análise estrutural da solução inicial, podem-se selecionar os parâmetros de entrada

e saída do problema. Ainda no ANSYS Mechanical para definir a altura e largura como parâmetros,

seleciona-se Cross Sections>Rectangle na janela Details of "Retangle" em Dimensions, seleciona-se

o quadrado ao lado de B e H, onde aparecerá uma letra P indicando que a altura e largura se tornaram

parâmetros de projeto.

Em Geometry na janela Details of "Geometry" em Properties seleciona-se o quadrado ao lado

de Mass para a massa ser um parâmetro e o ultimo parâmetro será a tensão máxima combinada,

onde seleciona-se Solution>Beam Tool>Maximum Combined Stress na janela Details of "Maxi-

mum Combined Stress" em Results seleciona-se o quadrado ao lado de Maximum.
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Com os parâmetros definidos, será adicionado o módulo Direct Optimization em Project Sche-

matic no Workbench. No Direct Optimization serão indicados quais parâmetros são os objetivos,

restrições e domínios, os parâmetros de domínio são a altura e largura pois são os parâmetros de en-

trada que serão modificados devido a função objetivo, ainda em domínio serão indicados os limites

superior e inferior da altura e largura, que serão 10 mm e 50 mm, como indicado na figura 4.22.

Figura 4.22 – Parâmetros de entrada

Em Objectives and Constraints serão selecionada a massa e a tensão máxima combinada como

parâmetros, onde em objetivo será selecionado para a massa minimizar e para a tensão maximizar,

a massa não terá restrições impostas, porém a tensão não deve exceder 200 MPa, como mostrado na

figura 4.23.

Em Optimization será definido como será realizada a otimização, a seleção do método pode ser

automática ou manual, caso se escolha manual pode-se escolher um dos métodos apresentados em

4.4.2, para o problema foi escolhido o método screening com um número total de 100 amostras e 3

possíveis candidatos. Com tudo definido para iniciar a otimização seleciona-se Update.
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Figura 4.23 – Objetivos e restrições do problema

4.5.3 Comparação de resultados

Na figura 4.24 mostram-se as mudanças na altura e na largura com as iterações que se seguem

até a convergência no ANSYS Mechanical APDL. Na figura 4.25, têm-se os resultados obtidos para os

3 candidatos a projeto ótimo, onde o melhor candidato tem a menor massa, atendendo as restrições

de projeto.

Figura 4.24 – Variação da altura e largura a cada iteração APDL
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Figura 4.25 – Redução de massa das 3 melhores geometrias no Workbench

Os resultados obtidos para os softwares são mostrados na tabela 4.1. Nesta, observa-se que os

resultados obtidos são semelhantes aos disponíveis na literatura, o que garante que ambas as ferra-

mentas conseguem gerar resultados confiáveis.

Variáveis Inicial Alberta APDL Workbench
Altura 20 mm 29,16 29,20 mm 29,40 mm

Largura 20 mm 13,24 12,54 mm 12,07 mm
Tensão 267,19 MPa 199,83 MPa 199,92 MPa 181,91 MPa
Volume 400000 mm3 386100 mm3 366162,35 mm3 355006,37 mm3

Tabela 4.1 – Comparativo entre solução inicial e otimizada para cada software

Vale ressaltar que apesar de ambos entregarem ótimos resultados, como mostra a tabela 4.2, o

tempo de otimização do ANSYS Workbench é muito longo. O ANSYS Mechanical APDL trabalha uti-

lizando uma única solução inicial em conjunto com as restrições e através de métodos computacio-

nais, utilizando a linguagem paramétrica, converge através de iterações usando os resultados obtidos

na iteração anterior como solução inicial de forma a obter um projeto ótimo no menor tempo pos-

sível. O ANSYS Workbench trabalha de forma distinta, pois apesar de utilizar métodos de otimiza-

ção paramétrica semelhantes, a otimização funciona criando uma quantidade inicial de candidatos

a projeto ótimo baseado nos limites dos parâmetros iniciais e com isso avalia esses candidatos de

forma a encontrar o projeto ótimo, com isso o número de iterações além de ser maior, tendo maior

custo de tempo, sofre com o fato que o módulo direct optimization não é parte do ANSYS Mechanical

(sendo que esse realiza a análise estrutural), assim a otimização é feita pelo ANSYS Workbench e a

análise estrutural é feita no ANSYS Mechanical, essa troca de informações faz o processo ser mais

lento ainda, justificando o tempo quase 30 vezes maior.
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Software ANSYS Mechanical APDL ANSYS Workbench
Tempo ∼2 min ∼60 min

Tabela 4.2 – Tempo de otimização para viga simples
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5 Exemplos de Aplicação - Resultados
obtidos

Nessa seção serão abordados os problemas de otimização paramétrica utilizando uma treliça pla-

nar (treliça de 10 barras) e uma treliça espacial (treliça de 25 barras), além de avaliar os resultados

obtidos com base na literatura existente em torno dos problemas abordados. Como o módulo de

otimização não está disponível nas versões mais recentes do ANSYS Mechanical APDL, optou-se por

utilizar o ANSYS Workbench para realizar os problemas de otimização, pois como mostrado em 4.5.3

os resultados apresentados pelo software se mostraram coerentes com os apresentados na literatura,

sendo um software de otimização com resultados confiáveis.

5.1 Problemas

Os problemas de treliça foram escolhidos por serem bastante utilizados em varias aplicações

como torres de linha de transmissão, torres de telefonia, máquinas de elevação, pontes, estrutura

de galpões, etc., além de existirem resultados disponíveis na literatura para tais problemas.

5.1.1 Treliça de 10 barras

O problema que será tratado é apresentado na figura 5.1 sendo uma estrutura treliçada com 10

barras, com limites de tensão de ±172 MPa e área de seção transversal mínima de 0,6451 cm2. O des-

locamento vertical terá limite de ±5,08 cm em todas as juntas e será realizado o caso onde P1=444,2

kN e P2=0. A área de seção transversal inicial será de 645,16 cm2 e o material será o alumínio.

Figura 5.1 – Treliça de 10 barras

As etapas para implementar a otimização no ANSYS Workbench são as mesmas apresentadas em

4.5.2, porém é necessário atentar ao fato que o elemento-tipo para treliças será o LINK180, sendo

esse extremamente sensível as desconexões das treliças, assim recomenda-se verificar as conexões
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dos elementos. Outra observação é que as barras devem ter somente dois nós, pois o elemento-tipo

LINK180 só reconhece elementos com dois nós. Além disso deve-se atentar ao fato que o deslo-

camento na direção z deve ser restringido nos nós da estrutura para este problema. Para alterar o

elemento-tipo da estrutura no ANSYS Mechanical, em Geometry, no Details de cada corpo de linha,

deve-se mudar Model Type para Link/Truss.

A geometria inicial é mostrada na figura 5.2 e a tensão nas barras para a área inicial é mostrada

na figura 5.3.

Figura 5.2 – Geometria inicial da treliça de 10 barras

Figura 5.3 – Tensão para solução inicial da treliça de 10 barras

O método de otimização escolhido foi o screening com 25 amostras e 3 candidatos possíveis.

5.1.2 Treliça de 25 barras

O problema que será tratado é apresentado na figura 5.4 sendo uma estrutura treliçada espacial

com 25 barras, com limites de tensão de ±275,8 MPa e área de seção transversal mínima de 0,06451
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Figura 5.4 – Treliça de 25 barras

cm2. A área de seção transversal inicial será de 6,452 cm2 e o material será o alumínio. As forças são

apresentadas na tabela 5.1.

Nó Px Py Pz

1 4,448 kN 44,48 kN -22,24 kN
2 0 44,48 kN -22,24 kN
3 2,224 kN 0 0
6 2,224 kN 0 0

Tabela 5.1 – Forças na treliça de 25 barras

A geometria inicial é mostrada na figura 5.5 e a tensão nas barras para a área inicial é mostrada

na figura 5.6.
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Figura 5.5 – Geometria inicial da treliça de 25 barras

Figura 5.6 – Tensão para solução inicial da treliça de 25 barras

O método de otimização escolhido foi o screening com 25 amostras e 3 candidatos possíveis.
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5.2 Resultados obtidos

5.2.1 Treliça de 10 barras

Os resultados obtidos na otimização utilizando o ANSYS Workbench são apresentadas na tabela

5.2, onde os valores das áreas são em metros quadrados. Como o método screening usa amostras

aleatórias, os resultados acabam sendo diferentes aos existentes na literatura, que utiliza métodos

distintos, assim os resultados obtidos podem ser comparados de forma qualitativa. Considerando

que os resultados obtidos atendem as restrições aplicadas e atendem o objetivo de redução de massa,

os resultados são considerados viáveis. Pode-se verificar que a diferença é significante nas barras

2,5,6 e 10, porém tais resultados são esperados, pois a abordagem de otimização e o método utilizado

é diferente aos presentes na tabela 5.2. Na figura 5.7 tem-se a geometria otimizada e na figura 5.8 as

tensões atuantes na estrutura otimizada.

Membro
Schmit and

Farshi
Schmit and

Miura Venkayya
Lee and

Geem Li et al. Workbench

1 0,0216 0,0198 0,0196 0,0194 0,0197 0,016426
2 6,45E-05 6,45E-05 8,25E-05 6,58E-05 6,45E-05 0,011009
3 0,0156 0,0153 0,0151 0,0146 0,01485 0,015456
4 0,0092 0,0094 0,0096 0,0098 0,0098 0,002417
5 6,45E-05 6,45E-05 6,51E-05 6,58E-05 6,45E-05 0,001566
6 6,45E-05 6,45E-05 6,51E-05 0,0003 0,0003 0,011528
7 0,0054 0,0055 0,0056 0,0049 0,0048 0,007259
8 0,0134 0,0136 0,0136 0,0139 0,0136 0,005669
9 0,0127 0,0135 0,0136 0,0138 0,0139 0,003931

10 6,45E-05 6,45E-05 0,00012 6,45E-05 6,45E-05 0,003161
Peso (kg) 2307,94 2302,43 2306,08 2293,82 2295,25 2196,4

Tabela 5.2 – Resultados para treliça com 10 barras

Figura 5.7 – Geometria otimizada da treliça de 10 barras
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Figura 5.8 – Tensão da solução otimizada da treliça de 10 barras

5.2.2 Treliça de 25 barras

Os resultados obtidos na otimização utilizando o ANSYS Workbench são apresentadas na tabela

5.3, onde os valores das áreas são em milímetros quadrados. Como o método screening usa amostras

aleatórias, os resultados acabam sendo diferentes aos existentes na literatura, que utiliza métodos

distintos, assim os resultados obtidos podem ser comparados de forma qualitativa. Considerando

que os resultados obtidos atendem as restrições aplicadas e atendem o objetivo de redução de massa,

os resultados são considerados viáveis. Na figura 5.9 tem-se a geometria otimizada e na figura 5.10 as

tensões atuantes na estrutura otimizada.

Membros
Schmit and

Farshi
Schmit and

Miura Venkayya
Lee and

Geem Lamberti Workbench

A1 6,45 6,45 18,06 30,315 6,45 454,72
A2:A5 1266,78 1280,325 1266,78 1304,19 1281,615 2705,81
A6:A9 1956,28 1932,42 1987,245 1902,75 1930,808 1505,41

A10:A11 6,45 6,45 6,45 6,45 6,45 1723,06
A12:A13 6,45 6,45 6,45 9,03 0,645 158,08
A14:A17 432,15 441,18 446,985 443,76 441,18 877,79
A18:A21 1083,6 1075,215 1082,31 1068,765 1081,601 412,91
A22:A25 1722,15 1716,99 1694,415 1717,635 1717,055 285,63

Peso (kg) 247,26 247,24 247,39 246,88 247,24 243,41

Tabela 5.3 – Resultados para treliça com 25 barras
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Figura 5.9 – Geometria otimizada da treliça de 25 barras

Figura 5.10 – Tensão da solução otimizada da treliça de 25 barras

5.3 Observações

O software ANSYS Workbench provou ser capaz de realizar otimização paramétrica e oferecer

bons resultados, além de ser prático e fácil de utilizar, porém o mesmo não pode ser dito quanto ao

tempo para realizar a otimização, na tabela 5.4 são apresentados os tempos de otimização para o

problema da treliça planar utilizando o método dos centros e formulação de força[3] que foi imple-

mentado em MATLAB e utilizando o ANSYS Workbench.

Trabalhos Farshi e Alinia-ziazi ANSYS Workbench
Tempo 1,25 s ∼60 min

Tabela 5.4 – Tempo de otimização para treliça planar
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Na tabela 5.5 são apresentados os tempos de otimização para o problema da treliça espacial utili-

zando o método dos centros e formulação de força[3] que foi implementado em MATLAB e utilizando

o ANSYS Workbench.

Trabalhos Farshi e Alinia-ziazi ANSYS Workbench
Tempo 17,24 s ∼60 min

Tabela 5.5 – Tempo de otimização para treliça espacial

A implementação no software MATLAB foi feita utilizando um PC, 1,3 GHz com 512 MB de RAM,

enquanto no software ANSYS Workbench foi utilizado um PC, 2,4 GHz com 8 GB de RAM, sistema

operacional Windows 10. Na simulação no ANSYS Workbench não foi utilizado aceleração de GPU,

quanto ao artigo não foi dito se houve aceleração por GPU.

Observa-se que apesar dos resultados entregues serem bons, o tempo de otimização é muito

longo, sendo recomendado o uso de uma linguagem de programação para resolver o problema em

um tempo mais curto, porém considerando que se trata de um software comercial, de fácil uso e

que dispensa a necessidade do usuário ter conhecimento de programação, o tempo pode não ser tão

relevante ao usuário.
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6 Conclusões

O mercado tem utilizado da otimização para redução de custos, mantendo a confiabilidade das

estruturas geradas, nesse sentido as ferramentas de elementos finitos como o ANSYS Mechanical

APDL e o ANSYS Workbench têm demonstrado suas capacidades em relação aos principais tipos de

otimização. O ANSYS Mechanical APDL perdeu seu módulo de otimização nas versões mais recen-

tes, que lhe permitia realizar otimização paramétrica, porém sua capacidade de realizar otimizações

continua através de sua linguagem paramétrica.

O ANSYS Workbench se tornou a ferramenta indicada pela ANSYS para realizar os principais tipos

de otimização e no capítulo 4 foi visto através do problema da viga simples que a ferramenta conse-

gue gerar resultados tão bons quanto os gerados pelo ANSYS Mechanical APDL, usando o mesmo

elemento-tipo, porém sua eficiência está longe de ser uma das melhores visto que o tempo de otimi-

zação é muito longo se comparado a seu antecessor.

Nos problemas de treliça realizados no capítulo 5 vê-se que os resultados obtidos pela ferramenta

usando o elemento-tipo LINK180 são bons quando comparados com os existentes na literatura, ape-

sar de um pouco distintos em algumas áreas das barras. As diferenças nas áreas se devem ao módulo

Direct Optimization gerar vários candidatos à solução do problema, usando os limites impostos aos

parâmetros de entrada, com isso, para obter o melhor resultado possível são necessárias várias ite-

rações. Com isso, otimizações que deveriam ser extremamente rápidas de serem concluídas, como

observado no método implementado em MATLAB por Farshi e Alinia-ziazi[3], levam longos tempos

dependendo do método de escolha e da quantidade de amostras. Além disso, devido os métodos

serem distintos, os resultados acabam sendo distintos, assim os resultados podem ser comparados

qualitativamente.

Com isso, o trabalho mostra que como ferramenta comercial, o ANSYS Workbench entrega bons re-

sultados para otimização paramétrica, além de ser uma ferramenta de fácil uso e que não necessita

de conhecimentos prévios de programação, porém em casos onde se necessita uma otimização mais

rápida, recomenda-se a implementação de métodos de otimização utilizando linguagens de progra-

mação. O tempo de otimização no ANSYS Workbench também pode ser reduzido utilizando acelera-

ção por GPU.
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A Anexos

Rotina do problema de viga de seção quadrada

*SET,W,20

*SET,H,20

!*

/PREP7

!*

ET,1,BEAM188

!*

MP,EX,1,200000

MP,PRXY,1,0.3

!*

K,1,0,0„

K,2,750,0„

K,3,1000,0„

L,1,2

L,2,3

!*

SECTYPE,1,BEAM,RECT„0

SECOFFSET,CENT

SECDATA,H,W,

!*

LESIZE,ALL„,10

!*

LMESH,ALL

!*

FINISH

/SOLU

!*

DK,1,UX,0

DK,1,UY,0

DK,3,UY,0

!*

NSEL,ALL

D,ALL,UZ,0

D,ALL,ROTX,0

D,ALL,ROTY,0

!*
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FK,2,FY,-2000

!*

ANTYPE,0

!*

SOLVE

FINISH

!*

/POST1

ETABLE,EVolume,VOLU,

SSUM

*GET,Volume,SSUM„ITEM,EVOLUME

!*

ETABLE,SBYB_I,SMISC,33

ESORT,ETAB,SBYB_I,0,1„

*GET,SBYBI,SORT„MAX

!*

ETABLE,SBYB_J,SMISC,38

ESORT,ETAB,SBYB_J,0,1„

*GET,SBYBJ,SORT„MAX

!*

*SET,SBYB,SBYBI>SBYBJ
!*

LGWRITE,optimize,txt,C:\Users\Andrei\Documents

!*

/OPT

OPANL,’optimize’,’txt’,’C:\Users\Andrei\Documents’

!*

OPVAR,W,DV,10,50,0.001

OPVAR,H,DV,10,50,0.001

OPVAR,SBYB,SV,195,200,0.001

OPVAR,VOLUME,OBJ„,200

!*

OPTYPE,SUBP

OPSUBP,30,7

OPEXE

!*

PLVAROPT,H,W

/AXLAB,X,Número de Iteracoes

/AXLAB,Y,Largura e Altura (mm)

/REPLOT
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